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NOTICE

Command Software Systems, Inc. (CSSI) reserves the right to make improvements in
the product described In this manual at any time and without prior notice.

This material contains the valuable properties and trade secrets of CSSI, a Florida
cogjoratlon, embodying substantial creative efforts and confidential information, ideas
and expressions, no part of which may be reproduced or transmitted in any form or by
any means, electronic, mechanical, or otherwise, including photocopying, and
recording, or in connection with any information storage or retrieval system, without
prior written permission from CSSI.

LICENSE AGREEMENT

This software package is protected by United States copyright laws and international copyright treaties, as well as other
intellectual property laws and international treaties.

1. License GrantsLicensor hereby grants Licensee the right to use, as set forth below, the number of copies of each version
number and language of Software set forth on the cover page of the License Agreement.

a. Application Products— For products which are classified in the Open License Estimated Retail Price List as belonging
to the Application Product Pool, the following applies:

(1) For application products not otherwise identified below, the following section is applicable
For each License acquired, Licensee may use one copy of the Software, or in its place, any prior version for the same
operating system, on a single computer.

Licensee may also store or install a copy of the Software on a storage device, such as a network server, used onlyrtminstall o

the Software on Licensee’s other computers over an internal network; however, Licensee must acquire and dedicate a License for
each separate computer on which the Software is installed or run from the storage device. A license for the Software may not be
shared or used concurrently on different computers.

Licensee must retain this License Agreement as evidence of the license rights granted by Licensor. By executing the rights
granted to Licensee in this License Agreement, Licensee agrees to be bound by its terms and conditions. If Licensee does
not agree to the terms of this License Agreement, Licensee should promptly return it together with all accompanying
materials and documents for a refund.

WARRANTY

CSSl warrants the physical diskette and the physical documentation to be free of

defects with respect to materials and workmanship for a period of thirty days from the

date of purchase. During the warr_antydperlod, CSSI will replace the defective disk or
documentation. This warranty is limited to replacement and does not encomRIass an

other damages. CSSI MAKES NO OTHER EXPRESS OR IMPLIED WARRANTIES ON THE
SOFTWARE INCLUDING THE WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE
AND THE WARRANTY OF MERCHANTABILITY.
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INTRODUCTION

Congratulations on choosing Command AntiVirus™ for Microsoft® Exchange for
outstanding security against e-mail-based computer viruses! Command AntiVirus
provides you with the latest technology for preventing the spread of computer
viruses through your Microsoft Exchange network. To receive the latest
information on updates and new releases, please take a moment to register your
product.

MAIN FEATURES

Command AntiVirus (CSAV) for Microsoft Exchanges a comprehensive anti-virus
protection program that:

Automatically disinfects virus-infected e-mail attachments without damaging
the attachments.

Installs quickly and easily on your server.

Performs on-access and on-demand scanning.

Quarantines infected files for disinfection, examination or deletion.
Generates multiple, detailed virus scanning statistics.

Runs as a Windows NT service and provides NT event logging.
Allows administrators to e-mail virus alert messages automatically.
Automatically sends disinfected e-mail to its intended recipients.
Provides a highly flexible scheduled scanning feature.

Uses state-of-the-art scanning technology to detect thousands of known
viruses and their variants.
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* Performs continuous background scanning.

* Uses easy to understand configuration options.

CHAPTER OVERVIEW

The Command AntiVirus for Microsoft Exchange Administrator's Guide consists
of the following chapters.

Chapter 1 - Introduction
This chapter provides an overview of CSAV including a list of features,
conventions, and system requirements.

Chapter 2 - Installation
Chapter 2 covers the product's installation, uninstall, and reinstallation
procedures.

Chapter 3 - Using Command AntiVirus

This chapter provides information on creating custom scans, setting scan
properties, and scheduling automatic scans. You will also find advice on
configuration settings, toolbar items, and menu bar options.

Chapter 4 - Automatic Update

Chapter 4 explains how to configure the automatic update feature. This feature
allows your system to update itself with the latest Command AntiVirus program
files and virus definitions.

Chapter 5 - Glossary

The glossary defines the terms that you need for a solid understanding of
anti-virus systems.

Appendix

This chapter gives a complete listing of all the keyboard shortcuts that are
available in CSAV. The chapter also provides information on service startup
options and virus natification variables.

Command AntiVirus for Microsoft Exchange
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CONVENTIONS USED

Indicates an area that requires special attention.

Indicates a helpful tip.

COURIER  Examples and messages appear in COURIER For example:

\SERVER\SHARE\UPDATE

KEY + The plus (+) sign between two keys indicates pressing both keys at the same
KEY time. For example, when asked to press CTRL+C, press and hold the control key,
and then press the letter “c” key.

CSAV The acronym used for Command AntiVirus.
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SYSTEM REQUIREMENTS

To install and operate CSAV for Exchange, your system should meet the following
minimum requirements:

* Pentium CPU
* 96 MB of RAM (128 MB recommended)
¢ 30 MB available hard disk space

* Microsoft® Windows NT® Server 3.51 with Service Pack 5 or higher or
Microsoft® Windows NT® Server 4.0 with Service Pack 3 or higher

* Microsoft® Exchange Server Release 5.0 or later
NOTE: If you are experiencing difficulties with memory usage prior to installing

the program, you may need to increase your server’s memory to insure the
proper operation of Command AntiVirus.

ADDITIONAL INFORMATION

WEB SITE

You will find a wealth of fascinating information on the Command Software
Systems web site. Do you have questions about viruses? Do you want to know
more about system security? Would you like to know the answers to our
customers’ most frequently asked questions? We provide comprehensive
information on viruses, products, events, employment opportunities and much
more. Plus, for your convenience, all of our readme files, quick start guides, and
manuals are available for online viewing.

Be sure to visit this exciting extension of Command Software Systems’ services
at www.commandcom.com or our web site in the United Kingdom at
www.command.co.uk .

HELP FILES

The Help files contain information that will assist you in using the product.

Command AntiVirus for Microsoft Exchange
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MAILING LIST SERVER

Registered users of Command AntiVirus can subscribe to Command Software
Systems’ mailing list server. As long as you have an Internet e-mail address, you
can obtain electronic natification of product updates and announcements. You
can also receive our newsletter and a variety of other services. For more
information, call Customer Satisfaction or visit our web site.

README.TXT

The latest information on product enhancements, fixes and special instructions
is in the README.TXT file that is included with the CSAV program files. If you

like, you can also review this file on the Command Software Systems web site

before you download the CSAV files.
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INSTALLATION

Installing Command AntiVirus™ (CSAV) for Microsoft® Exchange is a very
simple process. However, before installing the product, we recommend that you
read this chapter. This will help you to make some of the setup choices during the
actual installation procedure.

INSTALLING

NOTE: Before installing CSAV, make sure that Microsoft Exchange version 5.0
or higher is running on your server.

Also, make sure that you are logged on as:

A.

o o M w NP

an administrator on the local domain.

an Exchange Server administrator. This account should be the one on which
the Exchange services run.

Insert the CD-ROM.

Click the Start button.

Click Run.

Select Browse to search the CD for the EXCHANGE directory.

Change to that directory.

Double-click Setup.exe and click OK. After startup, the system displays the
Welcome dialog box.
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=]

Welcome to the C54% For Exchange Setup progranm.
Thiz program will install CSA% For Exchange on pour
- computer.

[t iz gtrongly recommended that you exit all wWindows programs
befare running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs you
have running. Click Mest to continue with the S etup progranm.

WARMIMG: This pragram iz protected by copyright law and
international treaties.

IInhautharized repraduction ar distribution of this pragram, ar any
portion af it, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozzible under |lawm.

Cancel |

Welcome Dialog Box

7. Click Next. The system displays the Software License Agreement

8. To accept the license agreement, click Yes. The system displays the Setup
Type dialog box:

Command AntiVirus for Microsoft Exchange
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Setup Type I
Click the type of Setup you prefer, then click Mext.

Program will be inztalled with the most commaon
optionz. Recommended for most uzers.

~ Custam r'ou may chooze the optionz pou want to install
Recammended for advanced uzers.

" Destination Folder

D:h. ACSAY For Exchange Browsze... |
< Back I Mewxt = I Cancel |

Setup Type Dialog Box

9. Select one of the following installations. We recommend the Typical
installation.

* Typical — Installs all required files.

* Custom — Allows you to choose whether to install program files and help
files.

10. Specify the Destination Folder for the CSAV for Exchange files. You can
accept the default destination folder or click the Browse button to select a
different folder.

11. Click Next. The system displays the Service Account Information  dialog
box.
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NOTE: If you chose the Custom installation, the system first displays the Select
Components dialog box. Select the components that you want to install and click
Next.

Service Account Information

=]

Pleaze zpecify a user with adminiztrative rightz. [f you are
wzing a nonlocal account, then tpe in the domain name
and the uzer name uzing a backslazh in frant af the uzer
Name.

Uzer Mame: I

Pazgword: I

To continue with Setup, prezs the HEXT button,

< Back I Ment » I Cancel

Service Account Information Dialog Box

12. Type the user name’s password in the Password text box. This identifies the
Windows NT account under which the Command AntiVirus services run.

NOTE: If you did not use the correct user name, the system displays a dialog box
that informs you that you have entered the wrong user name. The user name
should be the user name that installed Exchange Server.

Command AntiVirus for Microsoft Exchange
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13.

14.
15.

2-5

Click Next. The system displays a dialog box containing the following
message:

THE ACCOUNT HAS BEEN GRANTED THE‘'LOG ON AS A SERVICE "
RIGHT.

This right is required for the account to run the service.
Click OK.

The system displays the Select Service Start Options dialog box:

Select Service Start Options I

Pleaze zelect which options pou would like enabled for the
zEIVICEE.

V¥ tutomatically start the C5AY For Exchange On-access |
zervice on spstem startup.

¥ Start the C58% For Exchange On-access service upon
completion of inztallation.

¥ Automatically start the C58% For Exchange Scheduler
FErvice on system startup,

¥ Start the CS&% For Exchange Scheduler service upon
completion of inztallation.

MOTE: Setup recommendz that the zervices be started
automatically on startup for migsion critical systems

< Back I Mewxt = I Cancel

Select Service Start Options Dialog Box

This dialog box allows you to select the startup options for both the
On-access and the Scheduler services.
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The On-access service provides real-time virus protection for your Exchange
mail system. The Scheduler service allows you to schedule virus scans.

Select from the following options:

* Automatically start the CSAV for Exchange On-access service on system
startup.

e Start CSAV for Exchange On-access service upon the completion of
installation.

¢ Automatically start the CSAV for Exchange Scheduler service on system
startup.

¢ Start CSAV for Exchange Scheduler service upon the completion of
installation.

We recommend selecting all four options. This is the default setting.

16. Click Next. The system displays the Start Copying Files dialog box.

17. Click Next. The installation program begins copying the CSAV for Exchange
files to your system.

When the copying is complete, the system displays the CSAV for Exchange
Options dialog box.

Command AntiVirus for Microsoft Exchange
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CSAY For Exchange Options

B@ Specify the adminigtrator far the Microzoft Exchange
gerver. This mailbox will be used for MAP] alerts and the
move bo quarantine feature,

Adrminiztrator b ailbos

Specify the administrator far the Microzaft Exchanae zerver. This
mailbo iz uzed to zend AP alert meszages.

Adrministrator Mame:

Specify a quaranting folder name where infected items should
be moved.

Euaranting Folder:

|F'u|:-|i|: Falders\Quarantine

Browse. ..

Quaranting log file size: |54 3: kilabytes

(] | Apply | Cancel | Help |

CSAV for Exchan ge Options Dialo g Box

18. Use the Browse button to select an Administrator Name .

19. After you have selected the Administrator Name and the Quarantine
Folder, click Next. The system displays the Setup Complete dialog box.

You can also change the Exchange mail folder that holds infected files in
guarantine. The default is Public Folders\Quarantine
Browse button to select a Quarantine Folder from the Choose Quarantine
Folder dialog box.

2-7

. You can use the
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Setup Complete

Setup haz finizhed instaling C5AY For Exchange on pour
computer.

Setup can launch the Readke file and the C54Y Faor Exchange
Conzole. Chooge the options you want below.

[ Hes. | want to view the Feadie Fils

[ ez, | wart to launch C54% Far Exchange Conzole

Click. Finizh to complete Setup.

< Back I Finizh I

Setup Complete Dialog Box

20. Select whether you want to view the README file and/or run the CSAV for
Exchange console . We recommend that you view the README file as it
contains the latest information on the functionality of CSAV for Exchange.

21. Click Finish . This completes the installation of Command AntiVirus for
Exchange.

Command AntiVirus for Microsoft Exchange
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GETTING STARTED

To start using Command AntiVirus for Exchange, follow these steps:

On the Windows NT taskbar, click the Start button.

Select Programs .

Select CSAV for Exchange .

Click the CSAV for Exchange Console icon. The system displays the CSAV
for Exchange Console .

CSAV FOR EXCHANGE CONSOLE

CSAV uses a graphical user interface (GUI) that simplifies the customizing and
starting of virus scans. When you start CSAV for Exchange, the program
displays the CSAV for Exchange console

1.
2.
3. Select Command Software .
4.
5.

From the console , you can perform numerous scan task operations. For
example, you can create, start, modify, or delete virus scans. You can also
change the folder in which detected viruses are quarantined. These scan task
operations can be performed easily from the menu bar, the toolbar or through
the command buttons. For more information, see Using Command AntiVirus .

REINSTALLING COMMAND ANTIVIRUS

Reinstallation refers to installing CSAV for Exchange on a system that already
has a copy of the program installed. You can use this feature to restore the
original CSAV files and settings or to add components that you chose not to
install during the original installation.

that you perform a manual scan of your mail system after the reinstallation has

Ongoing virus scanning is stopped during reinstallation. We strongly recommend
completed.
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To reinstall CSAV, locate the EXCHANGE folder on the CD and run the
Setup.exe file. If the setup process locates existing CSAV for Exchange
information, the system displays the Reinstallation of CSAV for Exchange
dialog box.

Reinstallation of CSAY For Exchange

Fleaze zelect the reinztallation options.

WARMIMG: ONGOIMG WIRUS SCAMNMIMG wWiILL BE STORPPED
DURING REIMSTALLATION.

e gtrongly recommend that you perform a manwal zcan of your
mail zpstemn after the reinztallation has completed.

venarite
!J Cevenwrites all the previouzly installed program
— files, data files and zettings.

Freszerve Previous Ophions
Ovenwritez all the previouzly installed program
filez, but preserves the data files and settings.

Cancel

Reinstallation of CSAV for Exchange Dialog Box

This dialog box provides you with the following options:

* Overwrite — Replaces existing CSAV for Exchange files and settings with
new files and settings that are specified during the reinstallation.

Selecting this option overwrites the program files, the virus definition files,
and the CSSFTPR.NI file. The CSSFTPRINI file contains information on FTP
download sites and local directories that are used by the CSAV for Exchange
Automatic Update feature.

Command AntiVirus for Microsoft Exchange
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The Overwrite option also overwrites the program’s entries in the Windows
registry. The registry settings that are overwritten are:

Configuration settings for on-demand and on-access scans

Scan statistics for on-demand and on-access scans

Configuration settings for virus notification messages

Configuration settings for the Administrator and the Quarantine folder

Configuration settings for scheduled automatic updates

NOTE: The Overwrite option does not overwrite log files that were created
during on-access and on-demand scans.

* Preserve — Reinstalls the product without effecting the previous settings.
Existing CSAV for Exchange registry data is retained and used.

When the copying is complete, the system displays the Setup Complete dialog
box. If any system files were in use during the installation, you may be prompted
to restart your computer.

REMOVING COMMAND ANTIVIRUS

/A

To remove Command AntiVirus for Microsoft Exchange follow these directions.

To uninstall CSAV for Exchange from a Windows NT 3.51 server, use the
uninstallation icon in the CSAV for Exchange program group.

To remove CSAV for Exchange completely, you must restart your server.

1. On the Windows NT taskbar, click the Start button.
2. Select Settings .
3. Click Control Panel .
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N g &

10.
11.

INSTALLATION

Double-click the Add/Remove Programs icon.
Click the Install/Uninstall tab.
Select CSAV for Exchange from the list of installed applications.

Click the Add/Remove button. The system displays the Confirm File
Deletion message box.

Click Yes. The system displays the Remove Programs From Your
Computer dialog box.

Click OK. The system displays a confirmation message box that recommends
you restart your system. A system restart is required to completely remove
CSAV for Exchange.

Click OK.
Click OK to exit.

Command AntiVirus for Microsoft Exchange



USING COMMAND ANTIVIRUS

Command AntiVirus (CSAV) for Microsoft® Exchange gives your network
unbeatable security against virus-infected e-mail attachments. You can create
customized scan tasks, schedule automatic scans, and specify which action
CSAV takes when it finds a virus. The following sections describe the many
features that allow you to modify Command AntiVirus to your specifications.

THE CSAV FOR EXCHANGE CONSOLE

CSAV for Exchange uses a graphical user interface (GUI) that simplifies the
customizing and running of virus scans. The main screen of the GUI is called the
CSAV for Exchange console

Menu Bar  Toolbar Column Header Command Buttons

| | | |
{C CSAV For Exchange - EEH

Tazk ‘iew Toolz Help

gD ] e |m=lE ] 1] 2]

T azk Mame | Status J Last Result | Mext Scan On +
hElR ac Enatled A
ijj Scan Tech Dept.  Scheduled 1040241333 4:00am Dizable
ijj Scan Sales Dept. Scheduled 1040141333 1:00am .

A Properties

A Mew Tazk

1| | ]

For Help,|prezs F1

Task List Task Window SplitBar  Status Bar CSAV for Exchange Console
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From the console, you can perform numerous scan task operations. For example,
you can set the folder to which detected viruses are quarantined. You can also
create, delete, modify, select, start, and enable/disable virus scans from the
console.

Configuring individual scan tasks is possible through the easy-to-use options
found in the console's menu bar, toolbar or command buttons. A Task List in the
console can be used to access all major configuration features for any individual
scan task. For example, to change a scan's properties, highlight the scan task
name in the Task List and click the Properties button. To turn the on-access
(real-time) virus scanning on or off, select its scan task name in the Task List ,
click Task on the toolbar, and click Enable or Disable .

The console's menu bar contains Task, View, Tools , and Help menu items that
you can use to configure Command AntiVirus or to find help on how to use the
product’s features.

The console’s status bar displays the current state of a scan action. For example,
if you start an on-demand scan, the status bar informs you that the scan is
running.

TASK WINDOW

The main feature in the console is the Task Window . This window contains a
Task List with Task Names identifying the available scan tasks. The Status
column shows whether the on-access scan task is enabled/disabled or whether
any tasks are scheduled to run automatically. The Last Results column shows
the results of the last scan. The Next Scan On column shows the time of the next
scheduled on-demand scan.

ABOUT THE TASK LIST

You can create and configure scan tasks from the Task List . For example, you
can set properties for tasks and specify which actions to use upon detecting a
virus. You can also create an activity log file, schedule scan tasks to run
automatically and more.

Command AntiVirus for Microsoft Exchange
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Types of Scan Tasks

CSAV uses two types of scan tasks, on-access and on-demand. The on-access
scan task runs continuously in the background. When CSAV for Exchange
detects incoming or outgoing e-mail, the on-access scan takes place
immediately. Because the scan takes place entirely in the background, it does not
interrupt the workflow on your Exchange network.

NOTE: CSAV for Exchange can have only one on-access scan task. You cannot
delete or schedule the on-access scan task. However, you can configure it to
handle viruses according to your requirements.

On-demand scan tasks require that you start the scan manually. On-demand
tasks scan e-mail attachments in folders and mailboxes upon request. You start
an on-demand scan by selecting an on-demand scan task from the Task List and
clicking the Execute button. You can create multiple on-demand scan tasks and
configure each one to function according to your needs. On-demand scan tasks
can be scheduled to start automatically. These are often referred to as scheduled

scans.
T azk Mame | Statuz | Last Besults i Mext Scan On |
E@r CSAY On Access Tazk Enabled
Q Scan Marketing Mailboxes JEETs St 09/19/1933 7:00pm
% Scan Suggestion Box Scheduled 19/19/1993 12:00...
Task Window

In the Task List , the two types of scan tasks are identified by the icons appearing
to the left of the scan task names. A computer icon indicates an on-demand
scan. A yellow C icon identifies the on-access scan.
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Sizing the Columns

If you select Details from the View menu, the Task Window displays column
headers. You can resize the headers by using your mouse pointer to drag the
header's left or right split bar.

Sort Order of Scan Tasks

You can sort scan tasks in the Task List by clicking the column headers. For
example, clicking the Last Results header alphabetically sorts scan tasks that
detected a virus. Clicking the Task Name header sorts scan tasks by their
names.

Changing Icon Size of Scan Tasks

You can change the size of scan task icons by selecting Small Icons or Large
Icons from the View menu. Clicking the Small Icons or Large Icons button on
the toolbar also changes the icon sizes.

The Large Icons view displays the scan task names below their icons. The
Small Icons view displays the scan task names to the right of the icons. These
views do not show the results of the last scan conducted or the next scheduled
scan time.

List or Details View of Scan Tasks

You can also view the Task List with or without details about each scan task.
Selecting List from the View menu displays a column of small icons with scan
task names to the right of the icons. Selecting Details displays a column of small
icons with the scan task names to the right of the icons. The Details view also
displays columns containing the results of the last scan and the time of the next
scheduled scan. The Details view is the only viewing option that displays column
headers.

Changing Scan Task Names

To change a scan task name, select its name in the Task List , click, pause, and
click again. Then, type the new name for the scan task. You can also use the right
mouse button (right-click) to click a scan task name and then select Rename
from the shortcut menu. If you make an error while typing in a new scan task
name, press the Esc key to go back to the original name.

Command AntiVirus for Microsoft Exchange
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USING THE CONSOLE

You can access CSAV for Exchange functions in numerous ways. From the
console , you can use the command buttons, the menu bar, keyboard shortcuts
or the toolbar to start scans or modify their properties.

COMMAND BUTTONS

The command buttons allow you to perform various scan task operations.
Highlight the scan task you want to run or modify. Then, select the appropriate
command button. For example, clicking the Execute button starts an on-demand
scan. Clicking the Properties button allows you to access the scan task
configuration features.

Execute

FPropertie=s

MNew Tagk

Command Buttons

NOTE: If you select an on-demand scan task from the Task List the uppermost
button is Execute . If you select the on-access scan task, the button is either
Enable or Disable depending on the status of the on-access scan.

When you click the New Task button, the system prompts you for a new scan
task name. After entering a name, click Properties to configure the task. After
you complete the task’s configuration, the new task is added to the Task List .
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SHORTCUT MENUS

Shortcut menus allow you to create, start, rename, modify or delete a task
entirely. They also contain other options to help you manage CSAV for Exchange.
Performing a right-mouse click anywhere in the Task Window brings up a
shortcut menu.

tG- CSAY For Exchange _ O]
Tazk Wiew Toolz Help
glz|0|m| $|m|e| = |Ele ] 2
T azhk Name | Statusz | Last Result | Mext Scan On
E@r CSAY On-accesz.. Enabled
@WE SRR 10/02/1939 4:00am Execute
& Sean Sales De o 104011939 1:00am —
Froperties
Hename
Delete Hew Tagk
LCopy Chrl+C
Statiztics...
Wiew Log...
1 3
FProperties  Chrl+F | J

For Help, prezs F1

Shortcut Menu

Items available on the shortcut menus vary depending on whether you selected
the on-access scan task name, an on-demand scan task name or performed a
right-click in a blank area in the Task Window . For example, if you right-click the
on-access scan task name, the system displays a shortcut menu containing the
Enable /Disable , Statistics , View Log , and Properties . If you right-click an
on-demand scan task name, the system displays a shortcut menu containing the
Execute , Rename, Delete, Copy, Statistics , View Log , and Properties items.

If an item on a shortcut menu is not available, it appears dimmed.
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MENU BAR

The menu bar in the CSAV for Exchange console contains Task, View, Tools,
and Help menus that you can access with a mouse or keyboard. These menus
contain options allowing you to create, modify, delete or run scan tasks.

TOOLBAR BUTTONS

The toolbar provides quick access to functions that can also be accessed from
other menus.

] 2 ]|

Toolbar Buttons

8[=[0[0] s]=[e] =

NOTE: You can move the mouse pointer over any toolbar button to display a
ToolTip that identifies the function of that particular button.

From the View menu, you can turn on or turn off the toolbar as needed.

Help

an object, the system displays a help screen containing information that is
relevant to that object.

k{} This button adds a question mark to the mouse pointer. When you point and click

OTHER WAYS TO ACCESS PROGRAM FEATURES

You can use the C icon in the system tray to access the program quickly. If you
double-click the icon, the system displays the CSAV for Exchange console . If
you right-click the icon, the system brings up the Tray Shortcut Menu .
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Launch Conzole
Launch Event Vigwer

Dizable C5AY On-access Taszk
Properties

Get Statistics
Beset Statiztics

About C54% For Exchange K& 12:03 P

Tray Shortcut Menu

The tray shortcut menu allows you to:

* Open the CSAV for Exchange console

* Run Windows’ Event Viewer

* Enable or disable the on-access scan task

* Change the on-access scan task properties

* View on-access scan statistics

* Reset the counters in the Statistics dialog box

* View copyright and product version number information

USING THE QUARANTINE FEATURE

The quarantine feature allows administrators to move infected attachments to a
secure location for evaluation, disinfection or deletion at a later time.

Before you can use the quarantine feature, you must specify a quarantine folder.
For more information, see Options in Using the Tool Menu located later in this
chapter.
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To move infected files to the quarantine folder automatically, you must select the
Quarantine infected items automatically ~ option in the Actions dialog box. For
more information, see Action to Take on Infection in Configuring Scanning
Properties located later in this chapter.

QUARANTINE LOG FILE

If files have been moved to the quarantine folder, corresponding entries for these
files are added to the quarantine log file. This log file is named History.log . Itis
found in the CSAV for Exchange installation folder. The History.log file provides
information on the following:

* The original location of the e-mail

* The host name of the computer that was running CSAV for Exchange
* The name of the user under which CSAV for Exchange was running
* The date and time the log file was created or modified

* The subject of the e-mall

* The sender's name

* The recipients’ names

* The name of the quarantined attachment

* Whether the attachment was successfully quarantined

If a file attachment name is not found, the default file attachment name of
(Unknown) is assigned.

DISINFECTING QUARANTINED FILES

/A

You can create a scan task that disinfects infected attachments stored in the
guarantine folder.

Before scanning the quarantine folder, be sure that you have completed all
virus-related trouble-shooting or research in that folder. The disinfection process
leaves you without any quarantined viruses to examine for your own purposes.
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NOTE: When CSAV for Exchange disinfects a quarantined file, the file is
automatically resent to the original location from which it was quarantined.

To create a task that scans the quarantine folder and disinfects attachments that
are stored there, follow these steps:

1. Inthe CSAV for Exchange console , click the New Task button. A New Scan
Task is created at the bottom of the Task List .

2. Rename the New Scan Task . For example, you may want to name it "Scan
Quarantine Folder".

Press Enter to save the new scan task name.
Click the Properties button. The system displays the Detection dialog box.

In Items to scan , select the Scan selected items only  option.

o o M w

Click the Add button. The system displays the Browse Exchange Folders
dialog box.
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Browsze Exchange Folders

i Pleaze zelect a Microzoft Exchange public falder ar a
=s| recipient's mailbox.

-8 qatestNWOAITECHCOM
=1-{==] Public Folders
=] Intermet Mewsgroups
e} Ll uarantine
-7 Recipients

AN

[ Inchude Subfolders

Ok

Cancel

Befrezh

dilld]

Help

Browse Exchange Folders Dialog Box

7. Locate and select the quarantine folder.

3-11

NOTE: If you cannot remember the location of the quarantine folder, its path can

be found in the CSAV for Exchange Options dialog box.

8. Click OK. The system redisplays the Detection dialog box.

9. Select either Scan all file attachments or Scan only attachments of type

If you select Scan only attachments of type , click the Extensions button to

specify the types of attachments that you want scanned in the quarantine

folder. For more information on adding and removing attachment types, see
located previously

Detection Options in Configuring Scanning Properties
in this chapter.
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10.
11.

12.
13.
14.
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After specifying which Mail attachments to scan , click the Actions tab.

In When a virus is found , click the arrow and select Disinfect infected
items automatically

Click OK to return to the console .
In the Task List , select the scan task you have just created.

Click the Execute button.

After clicking the Execute button, the quarantine folder is scanned immediately
and the infected attachments are acted upon according to the action you
specified in When a virus is found . Disinfected e-mail messages are
automatically sent to their intended recipients.

USING THE TASK MENU

You

can access the Task menu by clicking Task on the menu bar.

tG- CSAY For Exchange _ O]
Yiew Tool: Help
il 1IN B EE B A L
Execute
[ batus | Last Result | Mext Scan On
Delete Task habled
cheduled 104021333 4:00am Execute

Edit b [cheduled 1040141939 1:00am Fropeftios
Properties... Chil+P —
Statiztics... New Task
Wi Liog...
E xit

4| | »]

Task Menu
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Items on the Task menu allow you to:

* Create a New Task

* Execute an on-demand scan task

* Enable/Disable an on-access scan task

* Rename a scan task

* Delete a scan task

¢ Copy and paste tasks through the Edit item
* Modify the Properties of a scan task

* View the scan Statistics of executed tasks
¢ Examine the log files through View Log

* Exit the CSAV for Exchange console

CREATING A NEW SCAN TASK

To create a scan task, select the Task menu and click the New Task menu item.
This creates a new scan task called New Scan Task at the bottom of the Task
List .

You can change the name of the new scan task by typing in the new name and
pressing Enter to save the change.

To configure the scanning characteristics of the scan task, select the scan task
name from the Task List . Then, select the Task menu and click the Properties
menu item.

For more information, see Configuring Scanning Properties located later in
this chapter.

EXECUTING A SCAN

To start an on-demand scan, select an on-demand task from the Task List . Then,
select the Task menu and click the Execute menu item. The system displays the
CSAV On-demand Task Execution dialog box and starts the scan immediately.
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iz C5AY On-demand Taszk Execution - Mannew Scan Tazk [_ O]
Current item being scanned...
Folder Hame Meszage Sender's Hame | Infected By Status -
{D Public Folde...  MAILOOOZ: Mz, Demo EICAR_Test_... Infected
{D Public Folde...  MAILOOOZ: Mz, Demo =37 Testka,..  Infected
{D Public Folde...  MAILOOOZ: Mz, Demo #F/Testtacro Infected
{D Public Folde...  MAILOOOZ: Ms.. Demo #F/Testtacro Infected
{D Public Falde... MAILOOOZ: Mz... Demao ®F/TestMacra...  Infected
{D Public Folde...  MAILODDZ: Msz.. Demo WM TestM.. Infected
(1) Public Folde.. AMAILOO0Z: Mz Demo Wit/ TestMacr.  Infected -
Pause Scan | Cancel Scan __‘;3
Scanning...

Task Execution Window CSAV On-demand Task Execution Dialog Box

The name of the scan task appears in the title bar of the dialog box.

The Current item being scanned text box displays the names of files that are
being scanned. As files are scanned in real-time, the names displayed in this text
box change quickly.

The Task Execution Window displays columns for the following:

* Folder Name - Contains the addresses of any infected files. If you cannot
see the full path for a file in Folder Name , use your mouse to drag the right or
left border of the Folder Name column header until you can see the full path.

* Message — Contains the subjects of the messages that were scanned.
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¢ Sender's Name - Contains the names of the individuals who sent the
messages.

* Infected By - Lists the names of the viruses that are infecting the e-mail files.

¢ Status — Reports what action CSAV for Exchange performed on the infected
files.

The On-demand Task Execution dialog box also contains the following buttons:
* Pause Scan — Suspends the current scan.
* Resume Scan — Continues the scan from the spot at which it was paused.

¢ Cancel Scan - Ends the current scan before all items targeted by the scan
have been scanned.

ENABLE/DISABLE

To start or stop the on-access scan task, select the on-access task in the Task
List. Then, select the Task menu and click either the Enable or Disable menu
item.

RENAMING A SCAN TASK

To rename a scan task, select the task’s name in the Task List . Then, select the
Task menu and click the Rename Task menu item. Type the new name of the
scan task and press Enter.

DELETING A SCAN TASK

To delete a scan task, select the task name from the Task List . Then, select the
Task menu and click the Delete Task menu item.

NOTE: The on-access scan task is a permanent feature in CSAV. It can be
configured, but it cannot be deleted.
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EDITING A SCAN TASK

The Edit menu item allows you to Copy and Paste scan tasks in the Task List .

If you use the Copy item, be sure to modify the properties of the new scan task
so that they do not duplicate the properties of the task from which it was created.

To copy an on-demand scan task named Scan Marketing Inbox , for example,
follow these steps:

In the Task List , click Scan Marketing Inbox .

On the menu bar, click Task. The system displays the Task menu.

Select Edit. The system displays a submenu.

Click Copy.

On the menu bar, click Task.

Select Edit. The system displays a submenu.

N o g M w DN PRF

Click Paste. A new scan task named Copy of Scan Marketing Inbox is
created in the Task List .

8. Type in the new name of the scan task.
9. Press Enter to save the change.

You can then modify the new scan task’s properties. For more information, see
Configuring Scanning Properties  located later in this chapter.

NOTE: As there can be only one on-access scan task. You cannot cut, copy or
paste the on-access scan task.

CONFIGURING SCANNING PROPERTIES

If you select Properties from the Task menu, the system displays the Properties
dialog box. This dialog box contains several other dialog boxes. For on-demand
scans, the available dialog boxes are Detection , Actions , Schedule , Reports ,
and Exclusions . Except for Schedule , the same dialog boxes are available for
the on-access scan. Each of these dialog boxes is identified by a name tab.
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When you click a tab, the system displays the dialog box referenced by the tab.
For example, clicking the Actions tab displays the Actions dialog box.

Each scan task must have its properties individually configured. The following
sections provide instructions on how to use the Detection , Actions , Schedule ,
Reports , and Exclusions dialog boxes to configure the on-access scan and
on-demand scans.

Detection Options

The Detection dialog box allows you to select which mailboxes, folders, and
types of attachments to scan.

those selected in the Exclusion dialog box, these objects are excluded from
scanning. This is because the Exclusion dialog overrides the Detection dialog for
the same items.

f If some objects selected for a scan in the Detection dialog box are the same as

On-demand Scan Tasks

To configure the detection properties for an on-demand scan task, follow these
steps:

1. Select an on-demand scan task from the Task List .

2. Click Task on the menu bar. The system displays the Task menu.

3. Click Properties . The system displays the Properties dialog box with the
Detection dialog box visible.
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tG Properties
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=7 Fecipients\auturnn Kimnberly Cuztom

t ail attachments to 2can

% Scan all file attachments

(" Scan only attachments of bype:

k. Cancel | Apply | Help |

Detection Dialog Box (On-demand)

4. In Iltems to scan , select one of the following:

* Scan all public folders and mailboxes = — Scans all of the Exchange
mailboxes and folders. If you select this option, go to Step 8.
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* Scan selected items only — Adds, edits, and removes mailbox and folder
locations from the list of items to be scanned. Selecting this option
activates the Add button.

5. To add an item to the scan, click Add . The system displays the Browse
Exchange Folders dialog box.

NOTE: You can use the Edit and Remove buttons in the Items to scan group
box to edit and remove items listed in the Item column.

Browsze Exchange Folders

i Pleaze zelect a Microzoft Exchange public falder ar a 0k
= s| recipient's mailbox.

~ @8, qatest3\0A3TE CHCOM " Eete]
+-{==] Public Folders Fefresh
—-[7™ Recipients —
=3 Adminiztrator
=3 Autumn Eimberly
i=3 ¥.atie Johnson
i=3 | indsey Johnson —
=3 Matrick Polan
=3 Mieves Snow
i= Pam Givarks ﬂ

Help

dildi]

IV Inbox [ Deleted Items [ Others
Iv Dutbaox [ Sent ltems

Browse Exchan ge Folders Dialo g Box

6. Inthe Browse Exchange Folders dialog box, select the folder or mailbox that
you want the task to scan.

¢ If you select a mailbox, select the mail items (Inbox , Outbox , Deleted
Items, Sent Iltems , and Others ) you want included in the scan.
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* If you select a folder, select the Include Subfolders option if you want to
include its subfolders in the scan.

7. Click OK to add the selected folders and return to the Detection dialog box.
8. In Mail attachments to scan , select one of the following:

* Scan all file attachments — Scans file attachments of all types (that is *.*).
If you select this option, go to Step 11.

¢ Scan only attachments of type —  Allows you to specify a list of
attachment types, for example, file extensions, that CSAV will scan.
Attachment types are identified by their file extensions. Click the
Extensions button to display the File Extensions dialog box.

with extensions listed in the File Extensions dialog box. If you select this option,
we recommend that you add the ZIP and AR? extensions to the file extensions
list.

f Scan only attachments of type  option provides coverage for only those files

NOTE: To provide the most up-to-date antivirus protection, the default
extensions in the file extension list may change from version to version.

File Extensions EH

Program file extenzsions:

APP - oK
BIM i

CObd

DLL Cancel

Lo

EE L ..
7

PG Bemowve
RTF

SCR [ Drefault
5

.5{_ [

File Extensions List  File Extensions Dialog Box
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9. Inthe File Extensions dialog box, use the following instructions to add or
remove an extension from the file extensions list:

To add a file extension, click Add . The system displays the New File
Extension dialog box.

Mew File Extension. ..
File Extenzion to add...
sed Cancel

New File Extension Dialog Box

* Type the three-character extension of the file type you want to add to the
file extensions list, for example, SED. Click OK to return to the File

Extensions dialog box. The extension is displayed in the contents of the
file extensions list.

* To remove a file extension, in the File Extensions dialog box, select the
extension you want to remove and click the Remove button. The
extension is immediately removed from the file extension list. Repeat this
process if you want to remove any additional extensions.

10. Click OK.

11. In the Detection dialog box, click OK to save your changes.

The Default button in the File Extensions dialog box resets the list to the
A default extensions. Any file extensions you added are lost.
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On-access Scan Task

The detection options for the on-access scan task differ from those available for
on-demand scan tasks. Both types of scan tasks have a Mail attachments to
scan group box with identical options. However, the Detection dialog box for the
on-access scan task has a General group box instead of an Items to scan group
box.

To configure the detection options for the on-access scan task, follow these
steps:

1. Inthe Task List , select the on-access scan task.

2. Onthe menu bar, click Task. The system displays the Task menu.

3. Click Properties . The system displays the Properties dialog box with the
Detection dialog box visible.
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tG Properties
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Detection Dialog Box (On-access)

In Mail attachments to scan , select gne of the following:
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* Scan all file attachments — Scans file attachments of all types (that is *.*).

If you select this option, go to Step 7.
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* Scan only attachments of type —  Allows you to specify a list of
attachment types, for example, file extensions, that CSAV will scan.
Attachment types are identified by their file extensions. Click the
Extensions button to display the File Extensions dialog box.

files with extensions listed in the File Extensions dialog box. If you select this
option, we recommend that you add the ZIP and AR? extensions to the file
extensions list.

f The Scan only attachments of type  option provides coverage for only those

NOTE: To provide the most up-to-date antivirus protection, the default
extensions in the file extension list may change from version to version.

File Extenszions

Program file extensions:
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! . . .
File Extensions List  File Extensions Dialog Box

5. In the File Extensions dialog box, use the following instructions to add or
remove an extension from the file extensions list:
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To add a file extension, click Add . The system displays the New File

Extension dialog box.

Mew File Extenzion. .

File Extenzion o add. .

sed Cancel

i

New File Extension Dialog Box

Type the three-character extension of the file type you want to add to the
file extensions list, for example, SED. Click OK to return to the File

Extensions dialog box. The extension is displayed in the contents of the
file extensions list.

To remove a file extension, in the File Extensions dialog box, select the
extension you want to remove and click the Remove button. The
extension is immediately removed from the file extension list. Repeat this
process if you want to remove any additional extensions.

6. Click OK.

7. Inthe General group box, select one or more of the following:

Enable CSAV for Exchange On-access service at startup — Starts
CSAV for Exchange on-access protection when your system starts.

CSAV On-access Task can be disabled - If selected, allows users at the
server running CSAV for Exchange to turn off the on-access scan task.
The on-access scan task can then be disabled (or reenabled) using the
Enable /Disable command that is available from the CSAV for Exchange
console . Disabling the on-access scan task stops automatic scanning of

new mail that is received or sent. It does not stop the CSAV for Exchange
on-access service.
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8. Show CSAV for Exchange icon on the taskbar ~ — Displays the yellow C icon
in the Windows system tray. Deselect this option if you do not want users at
the server running CSAV for Exchange to access the program through the
icon.

9. Click OK to save your changes.

Action to Take on Infection
The Actions dialog box allows you to specify the action to be taken when a virus
is detected. To specify an action, follow these steps:
1. Inthe Task List , select a scan task.
2. Onthe menu bar, click Task. The system displays the Task menu.
3. Click the Properties . The system displays the Properties dialog box.
4. Click the Actions tab. The system displays the Actions dialog box.
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Detection  Actions l Hepurts] E:-:u:lusiu:un]
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5.

Actions Dialog Box

In When a virus is found , click the drop-down-arrow and select one of the
following actions:

Log infection and continue —

Records information about the infected

attachments to a log file and continues the scanning process.
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* Quarantine infected items automatically —  Moves virus-infected
attachments to the quarantine folder.

* Disinfect infected items automatically —  Disinfects attachments. The
attachments are disinfected without any manual intervention. This is the
default setting. If an on-demand scan uses this option, the disinfected
attachment is reattached to the e-mail message.

If you select this option, you can also select the Remove all macros if
variant is found option at the bottom of the dialog box. This option
removes all macros from the infected attachment if a variant of an existing
macro virus is found.

¢ Delete infected items automatically —  Deletes the infected attachments
without any manual intervention.

deleting infected attachments can result in the loss of important information or
data.

f Use the Delete infected items automatically  option with care. Automatically
6. If you selected Log infection and continue , click OK to save your Action
settings. Otherwise, proceed to the next step.

7. Depending on the action that you selected in When a virus is found , one,
both or none of the following options are available in If specified action fails
Select only one option. If Quarantine attachment is available, it is the
default. Select the option that you want.

* Delete attachment — If the Disinfect infected items automatically  or
Quarantine infected items automatically ~ actions fail, enabling this
option assures that the infected e-mail object is not received by a user.

¢ Quarantine attachment — If the Disinfect infected items automatically

action fails, enabling this option assures that the infected e-mail object is
not received by a user.

8. Click OK to save your Action settings.
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Reports

In the Reports dialog box, you can specify the information to include in a scan
task’s activity log file. The default log file for the on-access scan task is
CSAVOnNAccess.log . The default log file for on-demand scan tasks is
CSAVOnDemand.log . Activity log files are stored in the CSAV for Exchange
installation folder. The latest scan information is appended to the end of the scan
task’s log file.

By specifying a different file name, the Log to file text box during the report setup
procedure, you can save a report to a file other than the default file. To view a
report for a scan task, select the scan task from the Task List and then select
View Log from the Task menu. In addition, log files can be viewed with any
standard text editor.

To customize a scanning report for a task, follow these steps:

1. Inthe Task List , select a scan task name.

2. Onthe menu bar, click Task. The system displays the Task menu.
3. Click Properties . The system displays the Properties dialog box.
4. Click the Reports tab. The system displays the Reports dialog box.
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Configure the logging of wirug activity, Specify the
information ko be captured for each log ento.

|ES.-’-‘-.‘-’EI rdcoess. log

¥ Limnit zize of log file to:

Wwehat to log
¥ |rfected tems detected
W Infected items disinfected

W Date and time

|'| 0o El: kilobtes

[+ Failure to natify Administratorz]

Browse...

¥ Infected items deleted
W Infected items guarantined

W User name

o |

Cancel

Help

Reports Dialog Box

5. Select the Log to file option to save a report to a log file. You can use the
default file name shown or click Browse to bring up the Select activity log

file dialog box.

6. Select Limit size of log file to

and set the size to fit your requirements. The

default size is 64KB ; the minimum is 10 KB ; the maximum is 999 KB.
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7. In What to log , select the types of information that you want logged:

Infected items detected — Reports how many viruses were detected.

Infected items disinfected — Reports the number of attachments that
were disinfected.

Date and time — Reports the date and time of the scan operation.

Failure to notify Administrator(s) = — Reports the names of all
administrators to whom virus notifications could not be sent. This option is
available only for the on-access scan task.

Infected items deleted — Reports the number of infected attachments that
were deleted during scanning (depends on the action selected for the scan
task).

Infected items quarantined — Reports the number of infected
attachments that were moved to the quarantine folder (depends on the
action selected for the scan task).

User name — Reports the name of the user logged into the NT system
running CSAV for Exchange.

NOTE: To specify which administrators should receive virus notifications, see
the section in this guide named Customizing Virus Notifications  located later
in this chapter.

8. Click OK to save your changes.

Scheduling Scans

You can configure on-demand tasks to perform scans automatically at a
scheduled date and time. The CSAV for Exchange console does not need to
be open for scheduled scans to start. Through the Properties dialog box,
administrators can assign a schedule to any on-demand scan task. Only
on-demand scan tasks can be scheduled.

If Details is selected in the View menu, the Task Window displays the status for
an on-demand scan task. For example, if the scan task is scheduled to run, the
Status column shows Scheduled . The date and time of the scan are shown in
the Next Scan On column.
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To schedule an on-demand scan task, follow these steps:

1. Inthe Task List , select an on-demand scan task.

2. Onthe menu bar, click Task. The system displays the Task menu.

3. Click Properties . The system displays the Properties dialog box.

4. Click the Schedule tab. The system displays the Schedule dialog box.

tC Properties

Detectiu:un] .-'-‘-.u:tiu:uns] Feports  Schedule lE:-:u:Iusiu:un]

_ Schedule the execution of the tagk.

¥ Enable scheduling

Scan frequency
" Daily
+ wieekly [ Mon W Tue [ wed [ Thu

Wi [ Sa | Sun

" Manthly |

Time to zcan [12 brs format] (0200 (A -

] | Cancel | Apply | Help

Schedule Dialog Box
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5. Select the Enable scheduling option.

6. Specify the Scan frequency by selecting one of the following:
¢ Daily — Runs once every day.

* Weekly — Runs on one or more days of the week. Select the days you want
the scan task to run.

* Monthly— Runs on a specified date once every month. Click the drop-down
arrow to select a date.

7. After you have selected a Daily, Weekly or Monthly scan frequency, use the
00:00 format to specify the time of day for the scans to start. In the Time to
scan (12 hrs format) box, type the hour and minutes. Click the down arrow to
select AM or PM.

8. Click OK to finish.

NOTE: The on-access scan task cannot be scheduled. It can only be enabled or
disabled.

Excluding Specific Items from Scans

/A

The Exclusion dialog box allows you to specify which items to exclude from
virus scans. For example, with an on-demand scan, you can exclude the Outbox
and Sent Items folder of a specific mailbox. With the on-access scan, you can
exclude entire mailboxes or certain folders.

If some of the items selected for scanning in the Detection dialog box are the
same as those in the Exclusion dialog box, those items will be excluded from
virus scans.

To exclude certain items from a scan task:

1. Inthe Task List , select a scan task.
2. On the menu bar, click Task. The system displays the Task menu.

3. Click Properties . The system displays the Properties dialog box.
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tG Properties

Detection | Actions | Reports  Exclusion l

|nform C5&Y For Exchange of all items, such az
mailboxes, which will be excluded from zzanning.

[ term
[Z3) Public Folderssnternet Mewsgroups

.......... = gll:l ........... Edt. | Remove |

2k, Cancel | | Help |

Exclusion Dialog Box

4. Click the Exclusion tab.

5. Click the Add button. The system displays the Browse Exchange Folders
dialog box.
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Browsze Exchange Folders

=3 Adminiztrator

=3 Autumn Eimberly

i=3 ¥.atie Johnson

i=3 | indsey Johnson —
=3 Matrick Polan

=3 Mieves Snow

i= Pam Givarks ﬂ

i Pleaze zelect a Microzoft Exchange public falder ar a 0k

é recipient's mailbox. _

— - gatest3v\OAITECHCOM 4] m
+-{==] Public Folders Befresh
=7 Recipients —

Help

IV Inbox [ Deleted Items [ Others
Iv Dutbaox [ Sent ltems

Browse Exchange Folders Dialog Box

6. Select the folder or mailbox that you want to exclude to from the scan.

¢ If you select a mailbox, select the mail items (Inbox , Outbox , Deleted
Items, Sent ltems and Others ) you want to exclude.

* If you select a folder, select the Include Subfolders option to exclude its
subfolders from the scan.

NOTE: If you want to exclude all folders, select Public Folders . To exclude all
recipients, select Recipients .

7. Click OK to save your modifications.

You can repeat the process for other folders or mailboxes.
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VIEWING SCAN STATISTICS

The Statistics menu item allow you to view the results of a scan.

To view the statistics for a scan task:

1. Inthe Task List , select a scan task.
2. Onthe menu bar, click Task. The system displays the Task menu.

3. Click Statistics . The system displays the Statistics dialog box for the
selected scan task.

NOTE: You can also view scan task statistics by right-clicking a scan task name
in the Task List and then clicking the Statistics item on the shortcut menu.

For on-demand scan tasks, the system displays the On-demand Task Statistics
dialog box. For the on-access scan task, the system displays the On-access
Task Statistics dialog box.

The On-access Task Statistics dialog box contains two buttons not found in the
On-demand Task Statistics dialog box. These two buttons are Enable/Disable
and Refresh . Enable/Disable starts or stops the on-access scan task and
Refresh provides up-to-the-moment on-access scan information.
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Infected Messages Window
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CSAY On-access Task Statistics

Scan Tazk: CSAV On-access Task
|nfected mezsages:
Folder Mame | Meszage | Sender's Mafne | Infectsd By | Stahuz | D ate and Time |
@ Recipientz\E... eicar ... emerson * EICAR_Test Quaran.. 8/3/337171:46:...
gl Recipients\E... testma... emerson Wi Testd  Disinfe .. 8/3/3311:48: ..
@J Recipientz\E... eicara ... emerzon EICAR_Test Quaran.. 8/2/393711:43:...
Ll Recipientshg... GSpam.. emerson WidiTesttd  Dizinfe .. 8/3/93 12563
EglRecipientshg... GSpam.. emerzon WikdiTesttd  Dizinfe .. 8/3/93 1253
EglRecipientshg... GSpam.. emerzon Wit Testtd  Dizinfe .. 8/3/9912:53..
"= P arimientzhn RSram oLy = R n L WM Tat Misinfer a0 125
Last zcan resulks
Location:  Recipientzhqatestsnbox
File name:  Recipientzgatestth nboxipacked. exe
Statuz: A Ma wiuzes found
Statistics
Scanned: a2 Infected: a0
Dizinfected: 25 [Quarantined: 15 Deleted: I}
Fefrezh Properties | | Help |
Dizable | | | LCloze |

Last Scan Results Group Box

Statistics Group Box

Task Statistics Dialog Box

The Infected Messages window in the Statistics dialog box displays the name
of the folder in which an infected file was detected. The name of the infected file
appears at the end of the folder's directory path.

The Infected Messages window also displays the name of the infected e-mail
message, the sender's name, the type of virus that infected the message, the
CSAV status of the message, and the date and time of the scan.
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The lower portion of the Statistics dialog box displays the Last Scan Results
group box. This box contains information indicating the location of the last folder
and last file scanned. The Status line indicates whether a virus was found during
the last scan.

The Statistics group box contains information on how many files were scanned,
disinfected, infected, and deleted. The group box also reports the number of files
that were moved to the quarantine folder. The counters in the Statistics dialog
box can be cleared by clicking the Reset Statistics button.

You can save the information in the Statistics dialog box to a text file by clicking
the Create Report button. The system displays the Save As dialog box. Name
the file and save it.

VIEWING THE LOG FILES

The View Log menu item allows you to view the contents of the on-demand or
on-access log file. A log file contains information on how many infected files were
found, disinfected quarantined or deleted.

To view the log file for the on-access scan task or an on-demand scan task, follow
these steps:

1. Inthe Task List , select a scan task name.

2. Onthe menu bar, click Task. The system displays the Task menu.

3. Click View Log . The system displays the log file.
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B C5A¥OnDemand.log - Notepad [_ (O] x|
Eile Edit Search Help

12731799 13:48:31 CSAal On-demand Task started: Scan
12731799 13:48:36 CSAl On-demand Task ended: Scan

Statistics:

Humber of files scanned: 1958

Humber of infected files found: 17
Humber of infected Files disinfected: 17
Humber of infected fFiles deleted: 8
Humber of infected files quarantined: 8

Scan all folders: Disabled

S5can all attachments: Enabled

Log to activity log file: Enabled

Limit log file size: Enabled

Delete attachment on fail: Enabled

Log infected attachment detected: Enabled
Log infected attachment disinfected: Enabled
Log infected attachment deleted: Enabled

Log infected attachment quarantined: Enabled
Log date and time: Enabled

Log user name: Enabled

Haximum log file size: 188 KB _j:J
3

Jl |

CSAV On-demand Log File

NOTE: If you have created a separate log file for a scan task, that log file
displays when you click View Log . For more information, see Reporting in
Configuring Scanning Properties  located previously in this chapter.
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USING THE VIEW MENU

The View menu allows you to change the appearance of the Task List as well as
turn the Toolbar and Status bar on or off. The View menu also allows you to get
the latest scan results by using the Refresh menu item.

Menu bar Toolbar
w ToolBar " | o |
ﬁ[ W Status Bar jll 7 N
Task:: Large Icons 3 | LastHesuIt| Mest Scan On
?@E" Small lcons led
=28 duled 10/02/1933 4:00am Execute
[ - :
=5 v Details duled 10401419933 1:00am T
Befregh F5& Hew Tagk
4| | ]
Status bar View Menu

TOOLBAR

This menu item turns the toolbar on or off. From the Toolbar you can create,
modify, delete, and run scan tasks. The toolbar also contains buttons for getting
product help and changing the appearance of the Task List .

NOTE: You can move the mouse pointer over any toolbar button to display a
ToolTip that identifies the function of that particular button.
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STATUS BAR
This menu item turns the status bar on or off. The status bar displays the current

state of a scan action. For example, if you start an on-demand scan, the status
bar displays the following message: "Executing the On-demand Scanning."

LARGE ICONS

This menu item displays the Task List as scan task names appearing below

large icons.

SMALL ICONS
This menu item displays the Task List as scan task names appearing below
small icons.

LIST
This menu item displays the Task List as a column of scan task names located
to the right of small icons.

DETAILS

As with the List item, Details displays the Task List as a column of scan task
names located to the right of small icons. Three column headers, Task Name,
Last Results , and Next Scan On also display.

REFRESH

This item updates the status of scan tasks in the Task Window . For the
on-access scan task, the status is updated to either Disabled or Enabled . For
an on-demand scan task, the Status, Last Results , and Next Scan On date are
updated.
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The Tools menu consists of the following items: Notification , Event Viewer ,
Automatic Update , and Options .

* Notification — Sends virus-related messages to specific individuals when
CSAV detects a virus-infected attachment through the on-access scan task.

* Event Viewer — Displays the major CSAV for Exchange operations.

¢ Automatic Update

{6 CSAY For Exchange M=)
Tazk Wiew W
M aotification... T [ == M
o ||: = = |55 | == ii|| b's |l:?
T Event Wiewer. .. | T 5
azk. Marne ext Scan O
BECSAW O Automatic Update...
% Scan Tec Ot 100241339 4:00am Execute
m phions. .. Chel+00 _ L=
=) Scan Salereepe . 10401,/1333 1:00am P 2
Froperties
Hewe Tagk
< 2]
Tools Menu

— Allows CSAV to update itself automatically with the

latest program files and virus definitions. For more information, see the

Automatic Update chapter.

* Options — Allows you to specify the name of the Exchange Server
administrator and to set the quarantine folder that temporarily holds infected

e-mail objects.
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VIRUS NOTIFICATION

CSAV for Exchange uses a powerful virus message notification feature. When a
virus-infected e-mail attachment is detected through the on-access scan task, by
default CSAV sends a mail alert message to the sender, the intended recipients,
and the administrator.

NOTE: The default administrator is the administrator specified in the Options
dialog box in the Tools menu.

You can change who receives a mail alert message , and you can also change
the text of the message.

Command AntiVirus for Exchange sends notifications only after an infected
e-mail attachment has been:

* Sent and then saved in the Sent Iltems folder.

* Received in the Inbox or in a Public Folder .

Notifications are not sent if a virus is detected through an on-demand scan.
However, if you have selected Send the mail alert to Recipient(s ) for the
on-access scan task, CSAV appends the on-access mail alert message text to
the body of the e-mail that contained the infected attachment. The e-mail is then
sent to its intended recipients.

NOTE: CSAV sends a mail alert message for each infected e-mail attachment.

For example, if CSAV detects an e-mail containing six infected attachments, the

specified mail alert message recipients receive six mail alert messages .
Customizing Virus Notifications

Customizing virus notifications consists of:

* Selecting a message header.

* Specifying who receives mail alert messages when a virus is detected
through an on-access scan. This can include the sender of an infected e-mail,
the e-mail’'s intended recipients, and selected administrators.

* Modifying the mail alert messages associated with the message header.
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To customize virus notifications, follow these steps:

1. Inthe Task List , select the on-access scan task.
2. On the menu bar, click Tools . The system displays the Tools menu.

3. Click Notification . The system displays the Notification dialog box.

Motification
4muEnn . . .
== hezzages to dizplay when an infection iz found. k.
|||%
Cancel

{B‘ Infected mail attachment found.

{B‘ Infected mail attachment was dizsinfected.

{D Infected mail attachment was deleted.

{D Infected mail attachment was quarantined.

{D IInable to diginfect the infected mail attachment.

Help
{D Ilnable to delete the infected mail attachment.
{D IInable to quarantine the infected mail attachment.
Message'Headers Notification Dialog Box

4. Select a message header, for example, Infected Mail Attachment Found

NOTE: All message headers are enabled by default. They cannot be deleted or
edited. Only the mail alert messages that are associated with each header can
be edited.

5. Click Edit. The system displays the Mail Alerts Configuration dialog box.
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Mail Alerts Configuration

*::-"I Pleasze configure who will receive the mail alerts when an
|||ﬁ infection is found and the message o send.

Iv¥ Send the mail alert to Sender
¥ Send the mail alert bo Becipient(s)

[ Send the mail alert bo Administratarz) Addresses. .

Configure the meszage ho zend bo |Sender

J

The meszage pou sent to ZRECIPIEMT % haz the file
attachment ZFILENAME 2 which is infected with the
EVIRUSMNAME % virus,

A
k. —l Cancel Help |

KRNI

Mail Alert Message Text Box

6. Select one or more of the following options. All are selected by default. Click

Mail Alerts Configuration Dialog Box

an option to deselect it.

NOTE: If you deselect all of these options, their message header in the

Notification dialog box displays an X over its icon.

Send the mail alert to Sender
Send the mail alert to the Recipient(s)

Send the mail alert to the Administrator(s)

3-45
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If you select Send the mail alert to the Administrator(s ), the Addresses
button becomes available. Click the Addresses button to view the Choose
additional addresses dialog box.

Chooze additional addreszes

Show Mames from the; |I3In:n|:na| Addrezs List j

Type Mame or Select from List:

Avtturnn Kirnberly ﬂ To-» J
K.atie Johnzon

Lindzey Joknzan
Hatrick Polan
Hiewves Snow
Fam Givorks
FPawel Kuvnotres
Faw W aughn
“Wan Ranters

4 Y J
Properties Find...

k. | Cancel | Help |

Choosing Additional Addresses Dialog Box

Select the administrators from the list and click OK to return to the Mail Alerts
Configuration dialog box.

who are not administrators. Use caution when selecting names from this dialog

The Choose additional addresses dialog box can contain the names of persons
A box.
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7. To modify the default mail alert message, click the Configure the message to
send to drop-down arrow and select, for example, the Sender. The mail alert
message that is sent to the Sender displays in the message text box.

8. Accept the default mail alert message for the Sender or edit it to fit your
requirements.

NOTE: When editing a mail alert message , you can use variables that identify
important aspects of the infected e-mail. For example, the “%VIRUSNAME%”"
variable can be used to identify the name of the virus that infected the e-mail’'s
attachment. For more information, see Mail Alert Variables inthe Appendix .

9. You can then reselect the Configure message to send to  drop-down arrow
and repeat Steps 6 and 7 for Recipient(s) and the Administrator(s) .
10. Click OK to save your changes.

You can always return to the Mail Alerts Configuration dialog box to modify the
mail alert messages .

USING EVENT VIEWER

In Windows NT's Event Viewer , you can view which CSAV events started or
ended. You can also view basic scan task statistics such as the number of files
scanned, infected, disinfected, deleted, and moved.

| | | 4]
To access Event Viewer , you can click the Event Viewer button on the
CSAV for Exchange toolbar. In Event Viewer , click Log on the menu bar. Then,

click the Application menu item. The system displays a log of
application-related events.
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i Event Yiewer - Application Log on YANT4MAIN

Log “iew Options Help

Date Time Source Category Ewvent User |[Computer
{1)9/2/98 1:3352 PM MSExchangeS. General G008 M/A  NTAMAIN =

{D9/2/98 1:33:52 PM MSExchangeS. General 5008 MA  NTAMAIN

€99/2/95 1:32:32 P tMEExchangel Maone 37 M MTabAIN T
1:32:32 P MSExchangeD M T b
€59/2/98 1:32:32 P MSExchangeD Mone 36 Mid MTakdAIMN
€59/2/98 1:32:32 P MSExchangeD Mone 37 Mid MTakdAIMN
09/2/98 1:32:32 PM MSExchangeD Mone 163 Mid MTakdAIMN
&59/2/98 1:32:32 PM MSExchangeD Mone 36 Mid MTakdAIMN
€5/2/398 1:32:.31 PM MSExchangeD Mone 37 Mid MTakdAIMN

9/2/98 1:32:31 P\ MSExchangeD Mone 163 Mid NTAMAIN -

Event Viewer Application Log

CSAV for Exchange uses four categories to identify events: General ,
On-demand , On-access , and Scheduler . These categories can be found in the
Category column.

Each CSAV for Exchange category contains several application-related events.
To see a detailed description of any CSAV event found in the Category column,
double-click the row pertaining to the event. The system displays an Event Detail
box with information on the event.

Command AntiVirus for Microsoft Exchange



UsSING COMMAND ANTIVIRUS

E vent Detail

Diate: 1044439
Tirne: 1:20:07 Pid
Uszer: [ P
Computer: CLA305

Deszcription:

Ewvent ID:
Source:
Type:
Categony:

19

CSA% For Exchange
Information
Scheduler

Scan Result Ma viruzes found'
Mumber of filez zcanned: '0°
Humber of infected files found: "0*
Mumnber of filez dizinfected: '0°
MHumber of filez deleted: ‘0
Mumber of files guarantined: ‘0"

Statiztics for Scheduled scan task 'Mew Scan Task 5%

K
Cloze | Breviousz

Hent

C

o

Help |

Event Detail Box
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OPTIONS

The CSAV for Exchange Options dialog box allows you to set the quarantine
folder location. You can also specify the administrator who is to receive virus
notifications.

NOTE: You can configure CSAV for Exchange to send virus notifications to more
than one administrator. For more information, see Configuring Virus
Notifications located previously in this chapter.

To set the Quarantine Folder and Administrator Name , follow these steps:

1. On the menu bar, click Tools . The system displays the Tools menu.

2. Click Options . The system displays the CSAV for Exchange Options dialog
box.
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C5AY For Exchange Options

B’@ Specify the administrator for the Microzoft Eschange
zerver. T hiz malbox will be uzed for MAPI alerts and the
move ko gquarantine feature,

Adrminiztrator b ailbos

Specify the administrator far the Microzoft Eschange server. Thiz
mailbox iz uzed to zend MAPI alert mezzages.

Adrminiztrator M ame;

Specify a quaranting folder name where infected items =hould
be moved.

Cluarantine Folder:

|F'u|:u|i|: Folderz\Quarantine

Browse...

Quarantine log file size: |54 El: kilabytes

()% | Apply | Cancel | Help |

CSAV for Exchange Options Dialog Box
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3. In the Administrator Mailbox group box, click the Browse button. The
system displays the Choose Administrator Name dialog box.

Chooze Administrator Hame

Show Mames from the; |I3In:n|:na| Addrezs List j

Type Mame or Select from List:

Autumn Eirmberly ﬂ
K.atie Johnzon
Lindzey Joknzan
Hatrick Polan
Hiewves Snow
Fam Givorks
FPawel Kuvnotres
Faw W aughn
“Wan Ranters

|
Properties Find...
] | Cancel | Help |

Choose Administrator Name Dialog Box

4. Select an administrator from the list of available names.

5. Click OK. The system redisplays the CSAV for Exchange Options dialog
box.

6. In the Quarantine Folder text box, specify the path to the quarantine folder.
The default is Public Folders\Quarantine . To change the path, click the

Browse button. The system displays the Choose Quarantine Folder dialog
box.
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Choose Quarantine Folder

; Pleasze zselect a Microzoft Eschange folder g
= Cancel
= 'ﬂ!, Command Software Sustemsz, [he W TECHCOMM M
=-{7) Publiz Falders Riefresh
() Intemet Mewsgroups
(1) Marketing Help

[Z3) Suggestions

« I

Choose Quarantine Folder Dialog Box

7. Select a quarantine folder from the list of available folders.

8. Click OK. The system redisplays the CSAV for Exchange Options dialog
box.

9. In the Quarantine log file size box, specify the size you want for the
guarantine log file. The default is 64 KB. The minimum size is 10 KB and the
maximum is 999 KB.

NOTE: The existing quarantine log file is overwritten when the amount of data
within it exceeds the limit you have specified in the Quarantine log file size  box.

10. Click OK.
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HELP MENU

The Help menu items allow you to locate information on topics of interest
including instruction on how to use the features found in CSAV for Exchange. You
can access this menu by clicking Help on the menu bar.

INDEX

Displays the Help Topics dialog box with Contents , Index and Find tabs. The
Contents tab lists major topics; the Index tab provides an alphabetical listing of
all topics; the Find tab allows you to search for a topic by key word. You can
select topics from the contents or the index for easy access to information.

USING HELP

This menu item displays a list of topics on the Help menu items. Click a topic to
view detailed information on the topic.

TECHNICAL SUPPORT

This menu item provides phone numbers and other information on contacting
your local technical support representative.

ABOUT CSAV FOR EXCHANGE

This menu item displays the product's version number and copyright information.
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AUTOMATIC UPDATE

This chapter contains instructions on how to use the Automatic Update feature.
This feature provides the easiest and most efficient method available for keeping
the latest version of CSAV for Exchange running on your system. Using the
Automatic Update feature assures that your Exchange mail system is always
being protected by the latest antivirus technology.

PREPARING FOR THE AUTOMATIC UPDATE

NOTE: To use the Automatic Update feature, Command AntiVirus must be
installed on each Microsoft Exchange server that will be updated.

NOTE: Automatic Update performs CSAV for Exchange component updates.
To perform a full-product update, you must run SETUP manually from the CSAV
for Exchange server.

CREATING THE AUTOMATIC UPDATE DIRECTORY

The Automatic Update feature operates by downloading update files into the
Windows temporary directory. This directory is called the staging directory .
These files are then immediately decompressed into a unique parent directory in
a shared location on the network. This directory is called the automatic update
directory . CSAV for Exchange then uses the files that were decompressed into
the automatic update directory  to update itself.
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NOTE: The server conducting the update must have Read access to the shared
Universal Naming Convention (UNC) location that contains the automatic
update directory .

Before CSAV can perform automatic updates, you must create the automatic
update directory .

Create the automatic update directory  on a shared location on the network, for
example:

\SERVER\SHARE\UPDATE

Then, when an on-demand or scheduled update takes place, CSAV for Exchange
does the following:

1. Downloads the update files from the FTP site to the staging directory.

2. Creates a CSAV for Exchange product directory within the automatic update
directory . The product directory is always a specific number, for example:

\SERVER\SHARE\UPDATE\0604

3. Creates separate subdirectories for the virus definition files and the update
component files. The definition files subdirectory ends in .00. The component
files subdirectory ends in .01. The file names are generated randomly by
CSAV for Exchange. The following is an example of the path names to the
automatic update directory and its subdirectories:

\SERVER\SHARE\UPDATE\0604
\SERVER\SHARE\UPDATE\0604\CSS43e.00
\SERVER\SHARE\UPDATE\0604\CSS282.01

4. Creates a file named CSSFILES.INI containing the following information:

[Win32-CSAV_Exchange]

BaseDir= \SERVER\SHARE\UPDATE\0604
Deffiles=CSS43e.00

Compont=CSS282.01

Decompresses the contents of the update file (component files, virus definitions,
etc.) into the appropriate directories in the automatic update directory
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NOTE: Every update creates a new definition and a new component files
subdirectory in the automatic update directory . Therefore, we recommend that
you periodically delete old subdirectories.

5. Performs an immediate update of CSAV for Exchange.

CONFIGURING THE AUTOMATIC UPDATE

The Automatic Update dialog box contains options that you can modify for the
automatic update process. The dialog box consists of the Update dialog box and
the Schedule dialog box.

The Update dialog box is divided into two sections. The upper section contains
the FTP Site group box. The lower section contains text boxes for the Automatic
Update directory path and the Staging directory path

By default, the FTP Site group box contains primary and secondary FTP site IP

addresses and product directories. It is from these sites that CSAV for Exchange

downloads its update files. You can change the primary and secondary FTP site

IP addresses if necessary.

If you decide to use non-default FTP site IP addresses, be sure to provide the
A correct paths to the CSAV for Exchange product directories at those addresses.

To open the Automatic Update dialog box, click Tools on the menu bar and then

click Automatic Update . The system displays the Automatic Update dialog box
with the Update dialog box in view.
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Automatic Update

Update l Schedule]

_ lze thiz page to specify where to obtain updates from.

FTF Site
Select ETP Site: | Primary FTP site |

Set the parameters for the Priman FTP zite;

IF Addrezs: |

Broduct Directany: |

zer Marme: |

Pazsward: |

Autormatic Update directory path:

| Browsze. .

Staging directary path;

| Browse. ..

Update now...

0k, | Cancel Apply Help

Update Dialog Box

Clicking the down arrow on the Select FTP Site text box allows you to select the
Primary FTP site or the Secondary FTP site . For example, if you select the
Primary FTP site , the information displayed in the FTP Site group box pertains
only to the primary site.
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The following information is required:

* |P address of the FTP site

* Product Directory on the FTP site

* User Name for the FTP site

* Password for the FTP site

* Automatic Update directory path  of the automatic update directory

To complete the required information, follow these steps:

1. Click the drop-down arrow in the Select FTP Site text box.
2. Select Primary FTP site from the drop-down list.

3. If you want to download CSAV for Exchange updates from the default site
proceed to Step 5.

If you want to download from a different site, in the IP Address text box, type
in the IP address for the FTP site.

4. In the Product Directory text box, type in the path to the CSAV for Exchange
update directory located on the FTP site.

5. In the User Name text box, type your user name for the FTP site.

6. Inthe Password text box, type your password for the FTP site.

7. Repeat Steps 1 through 6 for the Secondary FTP site .

NOTE: If the Primary FTP site is unavailable for downloads, CSAV for
Exchange automatically tries to download from the Secondary FTP site . For
this reason, we recommend that you always have complete and accurate
secondary FTP information in the FTP Site group box.

8. Type the path to the automatic update directory in the Automatic Update
directory path text box. You can also use the Browse button to locate this
path.

NOTE: If you do not specify an automatic update directory , the automatic
update process ends before the downloaded files are extracted.
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NOTE: You are not required to type anything into the Staging directory path
text box. By default, this text box is blank. CSAV for Exchange uses the Windows
temporary directory as the staging directory .

9. Click OK.

PERFORMING AN AUTOMATIC UPDATE

You can perform an immediate update of CSAV for Exchange or you can
schedule updates to take place at regular intervals.

NOTE: If the program determines that there are no CSAV for Exchange files that
need to be updated, the automatic update process ends.

Update Now

After you have entered all of the necessary information in the Update dialog box,
you can perform an on-demand update of CSAV for Exchange. To perform the
update, click the Update now button. CSAV for Exchange downloads the latest
update files and then immediately updates your system.

Scheduled Updates

You can configure CSAV for Exchange to download update files automatically
according to a schedule that you determine. The updating process occurs
immediately upon the completion of the download.

To schedule downloads, follow these steps:

1. Inthe Automatic Update dialog box, click the Schedule tab. The system
displays the Schedule dialog box.
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Automatic Update

Update Schedule l

_ Schedule the execution of the autamatic update.

Iv Enable scheduling
Scan frequency
" Draily

 twieekly [ Mon T Tue [ Wed [ Thu
[ Fi I Sat [ Sun

" Monthly

Scheduled download time [12 hour format] . (1201 [aM =

Mext Automatic Update zcheduled on: 01,01 42000 12:01 am

0k, | Cancel Apply Help

Schedule Dialog Box

2. Select the Enable Scheduling option.

3. Select Daily, Monthly or Weekly . If you select Weekly, select the days on
which you would like the scheduled downloads to occur. If you select

Monthly , click the drop-down arrow to specify the day of the month you want
the download to take place.
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4. Using the 00:00 format, type a time in the Scheduled download time (12
hour format) text box. Then, use the drop-down arrow to select AM or PM.

5. Click OK to save your changes.

Your CSAV for Exchange system is now configured to download update files
according to the scheduling information you provided.
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BOOT SECTOR

Stores critical drive information. Floppy disks and local hard disks have boot
sectors.

BOOT SECTOR VIRUS

A virus that infects the boot sector of a hard disk or a floppy disk. Note that any
formatted disk (even one that is blank or contains only text data) can contain a
boot sector virus. Booting with an infected disk activates this type of virus.

CIRCULAR INFECTION

A type of infection that occurs when two viruses infect the boot sector of a disk,
rendering the disk unbootable. Removing one virus usually causes a re-infection
with the other virus.

CMOS

Complimentary Metal Oxide Semi-Conductor. CMOS stores critical configuration
information. Some viruses try to alter this data.

COMPANION VIRUS

A virus that infects executable files by creating a companion file with the same
name but with a .COM extension. As DOS executes .COM files before .EXE files
and .BAT files, the virus loads before the executable file.
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CROSS-LINKED FILES

Cross-linking, a common situation rarely associated with viruses, occurs when
two files seem to share the same clusters on the disk.

DROPPER

A program compressed with PKLite, Diet, LZEXxe, etc... that contains a virus.
Microsoft Word documents can also function as droppers. A dropper deposits the
virus onto a hard disk, a floppy disk, a file or into memory. The children of this
process are not droppers.

EICAR TEST FILE

EICAR (European Institute for Antivirus Research) test file provides an industry
standard solution to test anti-virus products. The EICAR test file is the result of a
cooperative effort between various anti-virus researchers. You can use this file in
a variety of ways. For example, you can safely verify that real-time protection is
active and demonstrate what happens when it finds a virus.

ENCRYPTION

A process of making data unreadable. Some viruses use encryption techniques
in order to hide their presence from anti-virus scanners.

EXECUTABLE CODE

Instructions that a computer uses to accomplish various tasks. This includes
COM, EXE, DLL and similar files. In a broader sense, executable code includes
the code found in disk boot sectors, batch files and even macros used by some
applications.

FALSE POSITIVE

A false positive occurs when a scanner identifies a file as infected when, in fact,
the file is virus-free.
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FILE STEALTH

A virus characteristic that hides the increase in length of infected files. For
example, if the original size of a file is 240 KB, the file would appear to remain
the same size although the file now contains a virus.

FULL STEALTH

A virus that tries to hide its presence on an infected system. When operational, a
full stealth virus can evade attempts to search for it in files or memory.

HEURISTICS

A rule-based method of identifying new viruses. This method of scanning does
not rely on specific virus signatures.

The advantage of the heuristics scan is that new variants of existing viruses
cannot fool it. However, heuristics scans occasionally report suspicious code in

normal programs. For example, the scanning of a program may generate the
following message:

C:\DOS\MSHERC.COM has been modified by adding some code
at the end. This does not appear to be a virus, but

might be a self-checking routine or some "wrapper"

program.

Command AntiVirus issues a stronger warning based on the likelihood of a
program actually containing a virus.

INTEGRITY CHECKER

A program that checks for changes to files. Integrity checkers, when used

correctly, can provide an excellent second line of defense against new viruses or
variants.

JOKE PROGRAMS

A program that makes the computer behave oddly. Command AntiVirus detects
the presence of several well-known joke programs. While joke programs are
generally harmless, their side effects are often mistaken for those of a virus.




5-4 GLOSSARY

LOGIC BOMB

A program that runs a pre-programmed routine (frequently destructive) when a
designated condition is met. Logic bombs do not make copies of themselves.

MALWARE

A generic name for software that intentionally performs actions that can damage
data or disrupt systems.

MACRO VIRUS

A virus written in one of the many macro languages. The macro viruses spread
via infected files such as documents, spreadsheets, databases, or any computer
program that uses a macro languages.

MASTER BOOT RECORD (MBR)

The first physical sector on all PC hard disks reserved for a short bootstrap
program. The MBR also contains the partition table.

MEMORY-RESIDENT

Residing in computer memory as opposed to on the disk.

MULTIPARTITE

A virus that is able to infect both files and boot sectors. Such viruses are highly
infectious.

ON-ACCESS SCAN

A virus scan that starts when the operating system performs an action on a file.
For instance, when a file is created on the hard disk, Command AntiVirus'
on-access protection scans it immediately. If a virus is detected, CSAV performs
the action you specified in the on-access scan task settings.
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ON-DEMAND SCAN

A virus scan that is started manually. In CSAV, on-demand scans can also be
configured to scan automatically at a specified time (see the glossary entry for
Scheduled Scan ).

PARTITION TABLE

A place on a hard disk containing information required to access the partitions
(logical blocks) of a PC disk. The partition table also contains a flag indicating
which partition should be used to boot the system (the active partition). The
partition table is stored in the master boot record (MBR).

POLYMORPHISM

A virus in which the code appears to be different every time the virus reproduces
(though generally each reproduction of the virus is functionally identical). This
process is usually achieved by encrypting the body of the virus and adding a
decryption routine that is different for each reproduction.

SCHEDULED SCAN

An on-demand scan that is configured to run automatically each day, once a day
on specified days of the week, or once a month on a given date.

STEALTH VIRUS

A virus that tries to hide itself. Changes made by this virus are not easily
detected. For example, if the original size of a file is 240K, the infected file would
appear to remain the same size. A stealth virus can operate only when it is
resident in memory.

TROJAN (OR TROJAN HORSE)

A program that carries out an unauthorized function while hidden inside an
authorized program. This program is designed to do something other than what it
claims to and frequently is destructive in its actions.
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TUNNELING

A characteristic of some viruses that try to access the operating system directly,
bypassing any TSRs (including antivirus software) that have been loaded.

VIRUS

An independent program that reproduces itself. A virus may attach to other
programs; it must create copies of itself (see the glossary entry for Companion
Viruses ). It may attach itself to any executable code, including but not limited to
boot sectors and/or partition sectors of hard and/or floppy disks. It may damage,
corrupt or destroy data, or degrade system performance.

VIRUS SIMULATOR

A program that creates files that “look like” viruses. Such files are useless for
testing purposes because they are not really infected. Command AntiVirus is
smart enough not to be fooled by a simulator.

VIRUS VARIANT

A modification of a previously known virus, a variation.

WORM

A program that reproduces by copying itself over and over, system to system.
Worms are self-contained and generally use networks to spread.
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This appendix contains technical information on the special functions in
Command AntiVirus™ for Microsoft® Exchange. Some of these functions allow
you to accomplish tasks faster; others allow you to change the way the product

works.

KEYBOARD SHORTCUTS

The keyboard shortcuts allow you to save time in navigating through the product.
The following is a list of keyboard shortcuts for Command AntiVirus for Microsoft

Exchange.

LIST OF KEYBOARD SHORTCUTS

Command Keyboard Shortcuts
Task Menu Alt+T

Task Menu — New Task Alt+Tand N

Task Menu — Disable Alt+ T and D

Task Menu — Rename Task F2orAlt+Tand R
Task Menu — Delete Task Alt + Tand D

Task Menu — Properties Ctrl+ P

Task Menu — Cut Ctrl + X

Task Menu — Copy Ctrl+ C

Task Menu — Paste Ctrl+V

Task Menu — Statistics Alt+Tand S

Task Menu — View Log Alt+Tand V

Task Menu — Exit Alt + Tand X

View Menu Alt +V

View Menu — Toolbar At+Vand T
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View Menu — Status bar Alt+Vand S

View Menu — Large Icons Alt+Vand G

View Menu — Small Icons Alt + Vand M

View Menu — List Alt +V and L

View Menu — Details Alt +V and D

View Menu — Refresh F5or Alt+Vand R

Tools Menu Alt+ O

Tool Menu — Natification Alt+ O and N

Tool Menu — Event Viewer Alt+ O and E

Tool Menu — Options Ctrl+ OorAlt+ O and P

Help Menu Alt +H

Help Menu — Index Alt+Hand |

Help Menu — Using Help Alt+Hand U

Help Menu — Technical Support At+Hand T

Help Menu — About CSAV for Alt+ Hand A
Exchange

MAIL ALERT VARIABLES

Mail alert messages in CSAV for Exchange can use variables that are replaced
by specific values when the mail alert message is generated. For example, the
following mail alert message, as it appears in the Mail Alerts Configuration
dialog box, contains three different variables: %FILENAME%, %RECIPIENT%,
and %VIRUSNAME%:

The message you sent to %RECIPIENT% has the file
attachment %FILENAME% that was infected with the
%VIRUSNAME% virus.

When a virus is detected, the variables in the message are replaced by values. In
the previous example, the values consist of the e-mail’s intended recipients
(%RECIPIENTS%), the name of the infected e-mail attachment
(%FILENAME%), and the name of the virus infecting the attachment
(%VIRUSNAME%). Thus, the mail alert message received by the sender of the
infected e-mail would look something like:
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The message you sent to John Public has the file
attachment program.zip that was infected with the
Sylvia virus.

CSAV for Exchange uses five different variables. These variables are:

%COMPUTERNAME% — the name of the CSAV for Exchange computer
where the infection was found

* %FILENAME% — the name of the infected e-mail attachment
* %RECIPIENT% — the names of the intended e-mail recipients
e %SENDER% — the name of the e-mail sender

* %VIRUSNAME% — the name of the virus infecting the e-mail attachment

CSAV SERVICES STARTUP OPTIONS

Command AntiVirus for Exchange runs as two services. One is the CSAV for
Exchange Scheduler ; the other is the CSAV for Exchange On-access Task
Through the Windows NT Services dialog box, you can change the way the
CSAV for Microsoft Exchange services start. By default, the CSAV for Exchange
services launch automatically when Windows NT Server starts.

To prevent accidental virus infection, we recommend that you do not change the
default service startup options for CSAV for Exchange unless it is absolutely
necessary.

If you temporarily need to start or disable these services manually, follow these
steps:

1. On the Windows NT taskbar, click the Start button.

2. Select Settings .

3. Click Control Panel .

4

. Double-click the Services icon. The system displays the Services dialog box.




APPENDIX

Cloze

Startup Parameters:

Services
Service Statuz Startup
Alerter Started Automatic &
ClipBook Server bl izl
Computer Browser Started Automatic
CSAY for Exchange On-access service Started Automatic
CSAY for Exchange Scheduler Started Automatic
C55 A4 Scheduler Started Automatic
C55 Communication dgent Started Automatic
DHCP Client Dizabled
Directory Rephcator A b aral
EventLog Started Automatic j

Startup...

Hw! Profiles. ..

U]

Services Window

Services Dialog Box

5. In the Services window, select either the CSAV for Exchange Scheduler
service or the CSAV for Exchange On-access service.

6. Click the Startup button. The system displays the Service dialog box.
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7.

Service

Service: C5a% for Exchange Scheduler

Startup Type

SEE [ o ]
i Manua| Cancel

" Dizabled Help
Log On Az

" Suzkem Account

[ Allow Service ta Interact with Deskiop

¥ This Account: |E!.-’-‘-.-TEST-1 hga-admin J

HMMHEHMMHMRHNS

Pazzwaord:

Canfirm
Paszword:

EERETERERETTRT

Service Dialog Box

8. To finish, click OK.

In the Service dialog box, select which Startup Type you prefer: Automatic ,
Manual, or Disabled . Automatic is the default setting. If you select Manual,
the service that you selected in Step 4 starts only if you launch it manually

after Windows NT starts. If you select Disable , the service starts again only if
you reset the service to Manual or Automatic .
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